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= Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell
us your name, the name of the company who has licensed our products, the title and
part number of the documentation and the chapter, section, and page number (if
available).

Note: Before sending us your comments, you might like to check
that you have the latest version of the document and if any concerns
are already addressed. To do this, access the Online Documentation
available on the Oracle Technology Network Web site. It contains the
most current Documentation Library plus all documents revised or
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number
(optional).

If you need assistance with Oracle software, then please contact your support
representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your
Oracle local office and inquire about our Oracle University offerings. A list of Oracle
offices is available on our Web site at http://www.oracle.com.
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Audience

Preface

The Oracle Retail Process Orchestration and Monitoring User Guide describes the tracking
and managing of batch jobs.

This guide is for system administrators and operations personnel, integrators and
implementation staff personnel as well as users of the module.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing
impaired.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following;:

= Product version and program/module name

s Functional and technical description of the problem (include business impact)
= Detailed step-by-step instructions to re-create

= Exact error message received

= Screen shots of each step you take

Review Patch Documentation

When you install the application for the first time, you install either a base release (for
example, 4.0) or a later patch release (for example, 4.0.1). If you are installing the base
release, additional patch, and bundled hot fix releases, read the documentation for all



releases that have occurred since the base release before you begin installation.
Documentation for patch and bundled hot fix releases can contain critical information
related to the base release, as well as information about code changes since the base
release.

Improved Process for Oracle Retail Documentation Corrections

To more quickly address critical corrections to Oracle Retail documentation content,
Oracle Retail documentation may be republished whenever a critical correction is
needed. For critical corrections, the republication of an Oracle Retail document may at
times not be attached to a numbered software release; instead, the Oracle Retail
document will simply be replaced on the Oracle Technology Network Web site, or, in
the case of Data Models, to the applicable My Oracle Support Documentation
container where they reside.

This process will prevent delays in making critical corrections available to customers.
For the customer, it means that before you begin installation, you must verify that you
have the most recent version of the Oracle Retail documentation set. Oracle Retail
documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

An updated version of the applicable Oracle Retail document is indicated by Oracle
part number, as well as print date (month and year). An updated version uses the
same part number, with a higher-numbered suffix. For example, part number
E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all
previous versions.

Oracle Retail Documentation on the Oracle Technology Network

Oracle Retail product documentation is available on the following Web site:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

(Data Model documents are not available through Oracle Technology Network. You
can obtain them through My Oracle Support.)

Conventions
The following text conventions are used in this document:
Convention Meaning
boldface Boldface type indicates graphical user interface elements associated

with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Common User Interface Controls

Oracle Retail applications, such as the Oracle Retail Process Orchestration and
Monitoring application, include some common interface options and controls that you
can use throughout the application workflow. The following sections describe these
user interface controls in more detail.

Although you may have more than one Oracle Retail application installed on your
system, each application may use many of the same interface components and abide
by common rules and constraints.

You can quickly access the tasks of current applications and switch to other
applications from the Navigation bar. For more information on the Navigation bar, see
the Navigation Area section.

The following topics are covered in this chapter:
=  Logging on to the Application

= Navigation Area

= Specifying Preferences

= Table Menu Options

= Logging Out of the Application

Logging on to the Application
To log on to the application:

1. Click the User list menu on the top right of the Oracle Process Orchestration and
Monitoring window.

Figure 1-1 User List Menu

Accessivility ClrisAltsA

Login Ctri+AltsL

2. Click Login. The Welcome screen appears.
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Navigation Area

Figure 1-2 Welcome Screen

Welcome

3. Provide the following login information:
a. Enter your user name in the Username field.
b. Enter your password in the Password field.

4. Click Login.

Navigation Area

You can quickly access the tasks of current applications and switch to other
applications from the Navigation bar.

Figure 1-3 Navigation Bar

E <— Application Navigator

ﬁ «— Favorites

@ «— Tasks

‘g?:ﬁﬁ «— Notifications
Illl «— Reports

The following Navigation bar options are common across all the applications:
= Application Navigator

= Favorites

s Tasks

= Notifications

= Reports

Application Navigator

The Application Navigator is optional for the application and provides the ability to
switch between applications.

Note: Your view may vary, depending upon the features selected
during the setup process.

To switch between applications:

1-2 Oracle Retail Process Orchestration and Monitoring User Guide



Navigation Area

1. At the top left of the application, click the Application Navigator = icon to open
the list of available applications.

Figure 1-4 Application Navigator

Menu

E Application Navigator

* +" Process Qrchestrations and Monitering

2. Select the listed applications. The application will open in a new tab.

Favorites
You can select your favorite tasks without accessing the Tasks menu. It helps you
quickly get into your frequently used tasks.
You can click the Favorites icon in the Tasks menu to access tasks designated as
favorites. You can also select the cog icon from the Favorites menu to edit the favorite
list. Tasks can be selected or deselected as favorites in the Tasks menu.

Tasks

Oracle Retail applications support a variety of navigational tools and methods that
allow you to move efficiently between application pages. Information on how to use
and manage each of the tools and methods is included in this section.

A task is a set of links to a series of task flows organized in a specific sequence to
accomplish a business process or procedure. For example, tasks can be defined for
common multi-step procedures or processes so that you can quickly step through
tasks. By navigating sequentially to the pages outlined in the task, you are assisted in
stepping through the business process or activity.

Your Tasks list appears on the top left side of the home page. All of the tasks to which
you have access are listed on the Tasks window. You can either click on the specific
task name to open, or use the Task Search component to search for a Task that you
want to open.

To begin working with a task, choose the schedule and then the application feature or
process from the list.

Note: Your task menu may appear slightly different, depending on
your retail application.
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Figure 1-5 Tasks Menu

Tasks

\,  Search for a task

Schedules

v

<_Schedules

\,  Search for a task
MERCH ( 16.0.028 )
RI(16.0.28 )

RDE (17.0.001.3)

<

_ MERCH ( 16.0.030)

: \ Search for a task

Monitoring

Administration

jiiii

Monitoring
Search for a task

N

Batch Monitoring

Administration

\,  Search for a task

External System Configuration
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Notifications

Notifications bring events within the application to your attention.

See the following examples:

= A simple, informative message indicating a long-running process has completed

= A message indicating a critical exception has occurred

Figure 1-6 Notifications

Notification Badge

Motifications

% Search for a notification =

@ Batch execution emor

MERCH: Extamal Status Up

@ Batch execution amar

MERCH Job RDE_REFRESHODI
aneos

BATCH_USER

i Batch execution error
MERCH External S3atus Up

an0is
BATCH_USER

See All

The Notification Badge displays the number of unread notifications for the user in the
sidebar menu. The Notification Badge displays '99+', when there are more than 99

notifications.

The notification count is periodically refreshed at regular intervals. This interval is
determined by a system-configured value.

Figure 1-7 Notification Badge

vl
il

»
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Notification Sidebar

When you click the Notification icon, a Notifications Sidebar is shown that displays
the most recent set of unread notifications (depending on the filter set).

Figure 1-8 Notifications Sidebar

Notifications Search Bar

\, Search for a notification B —- Toggle View
Fites: @ «  Groupey @) = — Grouping Panel
Time Period
A . \—~ Filtering Panel
Type
Al v
Severity
Al -
Reset Filters Apply Cancel

No notifications to display

Search Results Panel

See Al = All Notifications Tab

Each component of the Notifications Sidebar is discussed in detail in the following
sections:

Search Bar

A search bar at the top of the panel allows for searching through notifications. The
search bar has auto-suggest enabled, so it displays notifications as the user types.

Right next to the search bar is the 'List/Group' view toggle button. This causes the
Notification results to be displayed either in a flat or grouped view.

Figure 1-9 Search Bar

3= =)

Test Notification to rms_Admin (3353}
Filters

Test Notification to rms_Admin (3352}

Error in
Test Notification bug fix 3 (3348)

LA Test Notification bug fix 2 (3347)
7. TestNotification bug fix (3346)

Test Notification (2830)

10 Test Notification 01/06 (2439)

9 Test Notification 01/06 (2438)

& 8 Test Notification 01/06 (2437)

Filtering Panel

The Filtering Panel allows you to filter notifications based on Creation time, Severity
and Type.
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The values for the Time Periods and Severity components are pre-seeded constants.
The Type drop-down lists all the notification types available in the system.

When you click the Apply button, notifications that match the criteria are shown in the

Results Panel.

Figure 1-10 Filtering Panel

Filters 0 - GroupBy M ~
Time Period

Any

Type

All v

Severity

All v

Reset Filters Apply  Cancel

Grouping Panel

This panel allows you to group notifications based on different attributes.

The values of the 'Group by' and the 'Then by' components are pre-seeded.

Figure 1-11 Grouping Panel

Filters o -

Group by

Tipe v

Then by

No Selection v

Reset Grouping Apply

Results Panel - List View

Group By

Cancel

When no selection is made in the Grouping panel, the Results Panel displays

notifications in a list format.

The image below shows a simple search without any filtering or grouping.

Figure 1-12 Results Panel - List View

Filters L]

, Error in Calculation

Important| __

Test Notificationtorms___

@ Errorin Calculation

Important

1. Indicates that no filtering was done.

2. Notification Type - A description of the Type is displayed.
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3. Read/Unread - A blue icon = is shown next to the notification if it is unread.

4. Notification Severity - A colored label indicating the severity of the notification is
shown.

5. Description - The description associated with the notification. If the notification
was designed to launch into a relevant flow, then this is displayed as a link.
Otherwise, the description is rendered as plain text.

6. Creation Time - A timestamp that shows the date and time at which the
notification was created.

7. User name - Creator of the notification.

Results Panel - Grouped View

Notifications are displayed in a grouped format within the Results panel, when the
Group By drop-down in the Grouping Panel is selected.

Notifications are displayed in groups with three notifications shown for each group.
Figure 1-13 Results Panel - Grouped View
Filters 0 - GroupBy @—— @

Errorin Calculation ——————————=—» @

@ Error in Calculation

Important

1. Indicates the Group-By drop-down is selected on the Grouping Panel.

2. The value of the Group-By attribute. In this example, the results were grouped by
Notification Type. Hence the Notification Type is shown as the header of the
group.

For each group, three notifications are shown followed by a 'See More' link. When you

click this link, up to 25 notifications are displayed for that group.

Results Panel - Summarized View

Notifications are summarized as shown in this example, when both the Group By and
the Then By drop-downs in the Grouping Panel are selected.

The summary view displays various groups and within them subgroups based on the
selections on the Grouping panel. For each subgroup, a count of the notifications
within that subgroup, grouped by severity is displayed.

The example here depicts a grouping by department, then by class.
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Notifications =

Figure 1-14 Results Panel - Summarized View

234 ®

1 Important ||| 4 Normal
1/8/17 1:02 AM

1. Indicates that both options on the Grouping Panel have been selected.

2. Firstlevel of grouping is by Department. Here the first department shown is
'deptl".

3. The subgroup within department 'deptl'. In this example, this is the Class name.
4. The number of notifications within that combination of Group and Subgroup.

5. A grouping by severity of all notifications within that combination of Group and
Subgroup.

6. The timestamp of the most recent notification of that combination of Group and
Subgroup.

All Notifications Tab
The All Notifications tab is shown when you click the 'See All' link at the bottom of the

Notifications side panel.

Figure 1-15 Al Notifications

[+] MNo:iﬁc.wLms. [+] AllUnread | | @ Critical Imgortant | @ Mormal

8977

Read | Unread

50

AChons v View v

Saverity

Cribcal
Cobcal
Cribcal

Crical

Crical

Baar

e @ No data to display No data to display

Fomatr X O B Y /| Detach Mark as Read
Status  Description Trpe Reciplents Creation Date Created By Last Updated Date Last Updated By

@ RiJobRSE_WKLY_SLS_PR_AGGR_PROC Batch execution emor | BATCH_USER 6222018 £ -
™ RADE_AREA_DH_LOAD.. Baich excution @ BATEH_USER 8223018

[ ] M_GRP_DH_LOAD_) Batch execution e 22208

[ ] O_ATTR_VALLIE_XREF }_JOB faled. Balch execution 622G

[ ] CAT_PROCESS_JOB faded for 034 Batch execution e 22208

L ] Balch execubon e 6222018

] £ Batch execution error 6222018

[ ] Ri:Job DT_LOC_RANGE_END_JOB faile Baich execution & B222018

] RIJob M_GRP_TC_LOAD_JOE faied toe Batch execution & 6222018

] 8222018 BATCH_USER

- e n smnmnas -

This tab lists all the notifications for the logged-in user, regardless of whether they are
in Read or Unread status. Information tiles display a break-up of the total notifications
by severity. Clicking these tiles refreshes the table below to display only those
notifications that are relevant to that tile.

You can perform the following operations from this tab.
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Delete ® - The table allows for multiple selection and hence multiple notifications
can be deleted at a time. Use the row header to select the row.

Refresh ® - This refreshes the list of notifications in the table.

Mark as Read - Multiple Unread Notifications can be marked as Read by clicking
this button.

Mark as Unread - Multiple Read Notifications can be marked as Unread by
clicking this button.

Reassign Notifications # - Notifications can be reassigned to individual recipients
or a group by clicking the Reassign Notifications icon. On selecting a row in the
All Notifications table, and clicking the icon, the reassign notification popup is
displayed. The Type is set to Reassigned by default, and the Severity and
Description are pre-populated from the selected row; you can then change any of
these values and assign the notification to one or more recipients.

Figure 1-16 Reassign Notification

Reassign Notification [x]
Severity Type
Critical B Reassigned B
Description
Individual notification reassigned
Choose Recipients Selected
\ benny| »

Benny Anderson

OK Cancel

The All Notifications table displays the following columns:

Notification Severity - A colored label indicating the Notification Severity.
Status - If the status is unread, an icon e« is shown. Otherwise it is blank.
Description - The description of the notification itself.

Type- The description of the Notification Type for the notification.

Recipients - In case of individual notifications, this column contains the user ID of
the user to whom the notification is assigned. When the notification is assigned to
multiple users, it displays the text 'Multiple' and enables a context popup which
lists all the recipients. This field is empty when the notification is assigned to a
group associated with a type.

Creation Date - Timestamp showing the date and time of creation.
Created By - User ID of the user who created the notification.

Last Updated Date - Timestamp showing the date and time when the last update
was made.

Last Updated By - User ID of the user who last updated the notification.
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= Application ID - Unique identifier that identifies the application. Not visible by
default.

s Department - The Department associated with the notification. Not visible by
default.

»  Class - The Class associated with the notification. Not visible by default.

= Subclass - The Subclass associated with the notification. Not visible by default.
s Location - The Location associated with the notification. Not visible by default.
= Supplier - The Supplier associated with the notification. Not visible by default.

s Performance - The Performance value associated with the notification. Not visible
by default.

= Brand - The Brand associated with the notification. Not visible by default.

= Rollup Count - The Rollup Count associated with the notification. Not visible by
default.

s Additional Information - Refers to the Additional Information attribute associated
with the notification. Not visible by default.

Reports

The functionality of Reports works similar to the Tasks menu.

Specifying Preferences

The Preferences pages are where you specify the default regional, language, and
accessibility settings that you want to use throughout the system.

To set your preferred preferences, click User list > Preferences at the top of the
application home page. The Preferences page appears. The standard preference
options available are as follows:

= Regional

s Language

»  Accessibility

To return to the application home page, click Back to Home at the top of the page.

Regional Options

Use the following options to specify the default formats for territory, date, time,
number, and time zone you want to use throughout the system.

Table 1-1 Regional Options

Value Description

Territory Specify the country details.

Date Format Select the date format that you want to use.
Time Format Select the time format that you want to use.
Number Format Select the number format that you want to use.
Time Zone Select the time zone you want to use.
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Language Options

Use the following options to specify the default language you want to use throughout
the system.

Table 1-2 Language Options

Value Description
Default Specify the default language you want to use.
Current Session Specify the language you want to use for the current session.

Accessibility Options

Use the following options to specify the default accessibility preferences you want to
use throughout the system.

Table 1-3  Accessibility Options

Value Description

Accessibility Select the accessibility option you want to apply.
Color Contrast Specify the color contrast that you want to use.
Font Size Specify the font size that you want to use.

Table Menu Options

Note: Figure 1-17, Figure 1-18 are representations and may be
different for every window/table/popup.

The Actions menu, View menu, and icons are displayed in the form of a table. For
more information on these options, see the sections Action Menu and Icons and View
Menu.

Action Menu and Icons

The Actions menu provides the option to take different actions related to entries in the
table. Depending on the nature of the table, these actions can be add, view, delete or
edit table rows, create by moving to a new screen or export the table contents to the
spreadsheet. Alternatively these actions can also be performed by using the icon
buttons on the table toolbar. For more information on the icon/buttons, see the Screen
Level Action - Icons and Buttons.

In some tables, it may also contain some table specific actions.

Figure 1-17 Actions Menu and Icons

m vewv & B  H Detach wrap @

Export to Excel
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Table Menu Options

View Menu

Table 1-4 Actions Menu/Icons and Descriptions

Actions Menu/lcon Description

Export to Excel and Export ~ You can export the records in the table to a Microsoft Excel
to Excel icon spreadsheet by selecting Actions > Export to Excel or by using
the Export to Excel icon El.

Refresh icon ® Use the Refresh icon ® to update the records in the table.
Not available in the Dependencies and External Dependencies
section.

Wrap icon You can wrap the values in the table column by first clicking the

column on which you would like the text to wrap and then
using the Wrap icon

The View menu provides the options for managing the table columns and sorting and
filtering the table data.

In some tables you have the option to choose a saved custom view, which is an
arrangement of columns different from the default view of the table.

Figure 1-18 View Menu

Columns »
Detach

Sort L4

Reorder Columns

Query by Example

Table 1-5 View Menu/Icons and Descriptions

View Menu List Description

Columns You can manage which of the columns will be shown in the table
by clicking the Show All and Manage Columns options.

Detach and Detach icon & You can view the tables in the application in a separate window
by clicking Detach or by using the Detach icon &,

Sort You can sort columns by the following options:
= Ascending

= Descending

= Advanced

Reorder Columns You can reorder columns by clicking the Reorder Columns
option.

Query by Example and You can filter the items by one or multiple column values by

Query by Example icon = clicking the Query by Example option or by using the Query by
Example icon &.

Screen Level Action - Icons and Buttons

The screen level actions display the icons and buttons.

Common User Interface Controls 1-13



Logging Out of the Application

Table 1-6 Screen Level Action - Icons/Buttons and Description

Icons/Buttons Description

Done Click Done to close the window.

Logging Out of the Application

Use the User list menu on the top right of the window, to log out of the application.

Figure 1-19 Logging Out of the Application

s POAM_VIEWER v (284

Preferences Cirl+Al+E

Logout Clri+Alt+O
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Process Orchestration and Monitoring

The Process Orchestration and Monitoring application is a user interface for
scheduling, tracking and managing, both nightly as well as intraday batch jobs.

Monitoring Batches

The Batch Monitoring window provides a runtime view of the statuses and
dependencies with regard to the different batch cycles running on the current business
day.

MERCH : Batch Monitoring %

CycleName Nightly

4 Batch Jobs

Actions v View v

To access the Batch Monitoring window from the Tasks menu, select Batch
Monitoring. The Batch Monitoring window appears.

The Batch Monitoring window contains the following sections.

Header

Batch Jobs

Dependencies

External Dependencies/Inter-Schedule Dependencies
All External Dependencies

All Inter-Schedule Dependencies

All Callbacks

Batch Monitoring Toolbar

Figure 2—1 Batch Monitoring

Auto Refresh None _.J All External Dependencies
" 4|
Business Date 04-May-2019 i dclons’y. Vew'v Detach )
Current Time 25-Mar-2019 12:33.09 AM EDT ik W Cenpinii Job ExternalJob  Status
StartTimestamp 22-Mar-2019 09:00:51 AM EDT 18 Skipped No data to display
e : M Running
FinishTimestamp 25-Mar-2019 12:33:14 AM £0T @ W Failed
Disabled
g System Held
Skipped On
Waiting for Pr
R
Y * Detach wrap @)
= < 2
; ependent Job o
Job Name Job Run Status  JobEnd Time  Job Run Time Parameters Extaptons »
RROR # = ;
e (RO SR ) Allinter-Schedule Dependencies
reimpurge ERROR #3ysOpt REIM
| ¥ AllCallbacks
reimedinjectar  ERROR #SysOpt REIM. =
Done
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Monitoring Batches

Header

Batch Jobs

4 Dependencies

Actions = View v 5 Y 7lDetach

Batch Job Dependency Type  Dependency
PONdoncy B | iatus

BDI_RFI_FinGenLdgr_Tx_PF_From_RMS_JOB FRE PENDING.

GL_EXTRACT_JOB FRE PENDING
RMSE_AIP_ALLOC_IN_WELL_JOB FRE PENDING
RMSE_AIP_CL_PO_JOB PRE PENDING
RMSE_AIP_FUTURE_DELIVERY_ALLOC_JOB FRE PENDING

W aaqq gy

4 External Dependencies

sotions = view v 1 [ Y| petach

External External
External Joh Dependencylype  EXternal Process e " Dependency Dependency
Status. Enabled

No data to display.

In the Header section select the monitoring cycle you want to view. The Monitoring
Cycle field lists all batch cycles configured for a business day, including the Nightly
batch cycle and the Adhoc cycle. When you choose a monitoring cycle the window
shows the results specific to the selected cycle. When you open the window, the
monitoring cycle defaults to the current or last run cycle for the current business day.

The screen can be set to auto refresh periodically by selecting the pre-defined interval
from the Auto Refresh list. By default, this value is set to None on page load which
means the Auto Refresh is turned off.

The Header section also contains a Run Status area, displaying the current business
date, the current time, the start time of the selected cycle and the expected end time of
the selected cycle, if the cycle has not yet been completed, or the actual end time, if the
cycle has already been completed. Use the Calculate icon to calculate the expected end
time.

In addition, the Run Status area shows a chart summary of the status of the different
batches that are included in the selected cycle. The possible statuses are listed below:

= Pending

= Completed
= Hold

= Skipped

=  Running

= Failed

= Disabled

= System Held
= Skipped on Error

= Waiting for Predecessor - Jobs that are waiting for completion of pre-dependencies
(Hourly Cycle, Nightly Cycle, External Dependency and Inter-Schedule
Predecessor Jobs).

The chart also shows the actual number of batch jobs in each of the status bins listed
above.

The All Batch Jobs section lists all the batch jobs and their statuses. The table displays
the following information:
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Monitoring Batches

= Job
= Job Name
= Job Run Status
Possible run statuses are:
- Pending
- Completed
- Hold
- Skipped
- Running
— Failed
— Disabled
- System Held
- Skipped on Error

= Average Run Time (in seconds) - Average run time for the batch job for the last
month

= Job Start Time

= Job End Time

= Job Run Time

»  Parameters

= Dependent Job Exceptions

The Dependent Batch Exceptions column indicates whether or not a dependent
batch exists. This field displays the parent job in exception status, such as ERROR
or HOLD.

Additionally, the following optional columns are available and can be managed in the
View Menu by selecting Columns > Manage Columns.

= Job Description

= Job Wrapper Name

s Previous Job Run Time (in seconds)
= Process

»  Process Status

= Operational Notes

= Application

= Job Waiting? - Waiting indicator

= Wait Reason

s Wait Time (In Seconds)

Process Orchestration and Monitoring 2-3



Monitoring Batches

4 Batch Jobs
Adions v Viewv )Y | Detach wrap

Joby

Wit Time (in

Process Process Status
Seconds)

Job Name Job Run Status  Parameters Job Waiting? Wait Reason

reimreceiptwriteol ERROR #SySOPLREIMA No REIM_RECEIPT.. LOADED
reimroliup ERROR #SYSOPLREIMA No REIM_ROLLUP.. LOADED
reimposting ERROR #SySOpLREIMA No REIM_POSTING... LOADED
reimegiinvdownl.. ERROR #5YSOpLREIMA No REIM_EDIINV_... LOADED
none SYSTEMHELD  Store_Fnd_Proc No BD1_Store_Fnd_.. LOADED
none SYSTEMHELD LOADED
SYSTEMHELD LT LOADED

SYSTEMHELD LOADED

SYSTEMHELD LOADED

Batch Jobs - Actions Menu and Icons
Use the Actions Menu and icons to apply actions to the table. You can perform the

actions listed below.

Table 2-1 Batch Jobs - Actions Menu/Ilcons and Description

Actions Menu/Icons

Description

Export to Excel and Export
to Excel icon #

View Audit Trail

View Cycle History

View Job Executions

Refresh icon @

Wrap icon

You can export the records in the table to a Microsoft Excel
spreadsheet by selecting Actions > Export to Excel or by using

the Export to Excel icon .
Opens the View Audit Trail window.

This option is to see the applications logs. Any user added
comments, actions taken, communications between JOS, POM,
and so on will be viewed here.

Click OK to close the View Audit Trail window.

Not available in the Dependencies and External Dependencies
sections.

Opens the View Cycle History window.

This option is only enabled for intraday cycles to view execution
logs for the job across the different enabled intraday cycles.

Click OK to close the View Cycle History window.

Not available in the Dependencies and External Dependencies
sections.

Opens the <JOB_NAME> Executions window.

This option is to view all the executions of a Job for the current
Scheduler Day.

Click OK to close the <JOB_NAME> Executions window.

Not available in the Dependencies and External Dependencies
sections.

Use the Refresh icon @ to update the records in the table.

Not available in the Dependencies and External Dependencies
section.

You can wrap the values in the table column by first clicking the
column on which you would like the text to wrap and then

using the Wrap icon

Not available in the Dependencies and External Dependencies
section.
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Dependencies

SALESGENRE.J_JOB Executions [x]
View i+ Detach
Execution ID Job Execution Start Time Job Execution End Time Status Logs
45540 25-Mar-2019 01:07:37 AM EDT  25-Mar-2019 01:07:38 AM EDT COMPLETED

OK

Batch Jobs - View Menu and Icons
You can customize the view of the table by using the options in the View Menu.

Table 2-2 Batch Jobs - View Menu/Icons and Description

View Menu/lcons Description

Columns You can manage which of the columns will be shown in the table
by clicking the Show All and Manage Columns options.

Detach and Detach icon &  You can view the tables in the application in a separate window
by clicking Detach or by using the Detach icon &

Sort You can sort columns by the following options:
= Ascending

= Descending

= Advanced

Reorder Columns You can reorder columns by clicking the Reorder Columns
option.

Query by Example and You can filter the items by one or multiple column values by

Query by Example icon & clicking the Query by Example option or by using the Query by
Example icon =,

Not available in the All External Dependencies section.

The Dependencies section contains post and pre-dependencies for any row selected in
the Batch Jobs section. The dependencies are displayed at a batch job level. The table
displays the name of the batch job, the dependency type and the status of the batch job
for the current day’s run, as well as the Dependency Enabled checkbox.

The Dependency Enabled checkbox indicates whether the dependency was respected
or bypassed in the current day's run.

Dependencies - Actions Menu and Icons

Use the Actions Menu and icons to apply actions to the table, see Table 2-1, " Batch
Jobs - Actions Menu/Icons and Description” for more information.
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Monitoring Batches

Dependencies - View Menu and Icons

You can customize the view of the table by using the options in the View Menu, see
Table 2-2, " Batch Jobs - View Menu/Icons and Description” for more information.

External Dependencies/Inter-Schedule Dependencies

The External Dependencies section lists external batch job dependencies and
inter-schedule dependencies. External Dependencies are identified by the Dependency
Type EXTERNAL.

The Inter-Schedule Dependencies section lists Jobs from one Schedule that are also
dependent on Jobs from another Schedule stored in the same POM instance.
Inter-Schedule Dependencies are identified by the Dependency Type INTERNAL.

The External Dependencies table displays the external job, Dependency Type, External
Process, External Schedule Name, the external dependency status, as well as the
External Dependency Enabled checkbox.

External Dependencies/Inter-Schedule Dependencies - Actions Menu and Icons

Use the Actions Menu and icons to apply actions to the table, see Table 2-1, " Batch
Jobs - Actions Menu/Icons and Description” for more information.

External Dependencies/Inter-Schedule Dependencies - View Menu and Icons

You can customize the view of the table by using the options in the View Menu, see
Table 2-2, " Batch Jobs - View Menu/Icons and Description” for more information.

4 External Dependencies

Actions v View v [7 ’7\ 7| Detach
External External
External Job DependencyType £X oy By Dependency  Dependency
Wh_Fnd_PracessFlow_From_RMS#end EXTERNAL PENDING I j
WeeklySales_Tx_ProcessFlow_From_RMS#end EXTERNAL PENDING 4
WeeklySales_Tx_FileCreator_ProcessFiow_From_RMS#end EXTERNAL PENDING 3
Uda_Fnd_ProcessFlow_From_RMS#end EXTERNAL PENDING I
Udavalues_Fnd_ProcessFlow_From_RMS#end EXTERNAL. PENDING 3
UdaltemLov_Frd_ProcessFlow_From_RMS#end EXTERNAL. PENDING 3
UdaAndUdavalues_Fnd_ProcessFlow_From_RMS#end EXTERNAL PENDING [
UdaAndUdavalues_Fnd_FileCreator_ProcessFlow_From_RMS#end EXTERNAL PENDING " 5|
All External Dependencies

All External Dependencies

Actions v Wiew Detach ()

Job External Job Status Blocking Enabled

CTESYS_JOB InvehtchFin_Tx_ProcessFlow_From_REM#end PENDING Mo v -]

DTESYS_IOB Invchtich&p_Tx_ProcessFlow_From_REM#end PENDING Mo v

DTESYS_JOB FinGenLdgr_Tx_ProcessFlow_From_RMSkend PENDING Mo v

DTESYS_IOB Diff_Fnd_ProcessFiow_From_RMS#end PENDING Mo v

DTESYS_JOB Diff_Fnd_FileCreator_ProcessFlow From_RMS#end  PENDING Mo v

DTESYS_IOB CurrConvRates_Fnd_ProcessFlow_From_RMS#end  PENDING Mo v

DTESYS_JOB CurrConvRates_Fnd_FileCreator_ProcessFlow_Fro...  PENDING Mo <

DTESYS_IOB Clearance_Tx_ProcessFlow_From_RMS#end PENDING Mo v

DTESYS_JOB Calendar_Fnd_ProcessFlow_From_RMS#end PEMNDING Mo ./

DTESYS_IOB Calendar_Fnd_FileCreator_ProcessFlow_From_RM...  PENDING Mo v

DTESYS_JOB Brand_Fno_ProcessFlow_From_RMS#end PEMNDING Mo ./

DTESYS_J0B Brand_Fne_FileCrestor_ProcessFlow_From_RMS#e... PENDING Mo v

RMSE_AF_STORE_.. EXT_TEST PENDING Yes (70 sec) v -

. | Ll
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Monitoring Batches

The All External Dependencies section is always displayed because External
Dependencies are at the schedule level.

The All External Dependencies section lists all the external batch job dependencies for
the entire current Schedule provided the system level external dependencies indicator
is turned on.

The All External Dependencies table displays the Job, External Job, Status, Blocking
and Enabled fields.

Clicking on the Job hyperlink will highlight the same in the Batch Jobs table.

The Blocking field indicates the time (in seconds) the Job started waiting for the
external dependency to complete.

All External Dependencies - View Menu and Icons

You can customize the view of the table by using the options in the View Menu, see
Table 2-2, " Batch Jobs - View Menu/Icons and Description” for more information.

All Inter-Schedule Dependencies

All Inter-Schedule Dependencies

Adtions v View ¥ " Detach 9

Job g:‘:;;‘::e External Job Status Blocking Enabled
CSTISLDSDE_JOB MERCH POSCDMLD_PO...  PENDING Mo v ;]
CSTISLDSDE_JOB MERCH STKVAR_JOB FENDING No v

CSTISLDSDE_JOB MERCH ELCEXCPRG_JOB  PENDING No v

CSTISLDSDE_JOB MERCH LIKESTOREBAT... PENDING No v

CSTISLDSDE_JOB MERCH BATCH_RFMCU...  FENDING o v

CSTISLDSDE_JOB MERCH REPL_INDCTN_P... PENDING No v

CSTISLDSDE_JOB MERCH EDIDLCON_JOB  PENDING No v

CSTISLOSDE_JOB MERCH PRICINGEVENTP... PENDING No v

CSTISLOSDE_JOB MERCH SAPURGE_JOB PENDING No v

CETISLDSDE_JOB MERCH SALESUPLOAD... PENDING Mo vy

CSTISLDSDE_JOB MERCH HTSUPLD_JOB PENDING No v

CSTISLDSDE_JOB MERCH ALLOCET_JOB PENDING No v

RESA2RDE_JOB MERCH RESA2DW_JOB  PENDING No v
RTLUASDE_W_DOMAIN_MEMBER_DS_... MERCH BATCH_ARCHIV... PENDING Yes (119 sec) v =

The All Inter-Schedule Dependencies section is always displayed since the
Inter-Schedule Dependencies are at schedule level.

The All Inter-Schedule Dependencies section lists all the inter-schedule batch job
dependencies for the entire current Schedule provided the system level inter-schedule
dependencies indicator is turned on.

The All Inter-Schedule Dependencies table displays the Job, External Schedule,
External Job, External Process, Status, Blocking and Enabled fields.

Clicking on the Job hyperlink will highlight the same in the Batch Jobs table.

The Blocking field indicates the time (in seconds) the Job started waiting for the
inter-schedule dependency to complete.

All Inter-Schedule Dependencies - View Menu and Icons

You can customize the view of the table by using the options in the View Menu, see
Table 2-2, " Batch Jobs - View Menu/Icons and Description” for more information.
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External System Configuration

All Callbacks

All Callbacks
Actions v View v “ Detach [l
Job Last Updated Date Created Date

DUMMY_START_MIGHT_BATCH_JOB 25-Mar-2019 05.04:58 AM EDT 25-Mar-2019 05:00: 24 AM EDT

STOP_RIB_ADAPTOR_IMY _JOB 25-Mar-201905:.04:58 AM EDT 25-Mar-2019 05:00:29 AM EDT
The All Callbacks section is always displayed since callbacks are displayed at the
schedule level.

The All Callbacks section lists all the external status update request and response
callbacks based on the External Status Update mode set in the External System
Configuration screen.

The All Callbacks table displays the Job, Status, Last Updated Date and Created Date
fields.

Clicking on the Job hyperlink will open the "Callback Info" popup that shows the
Callback URL configured in External System Configuration screen, Request Payload
and Response Payload.

Callback Info [x]

Callback URL hitp: fburO0clo us oracle com 8018:ExternalCallback Test App/batchibost
Callback Request ["processilame™"MERCH_DUMMY_START_NIGHT_BATCH_PROCESS" "processExecutionkd™ MERCH_DUMMY_START_MIGHT_B
ATCH_PROCESS~535fdfcd-

alﬂei[l‘&}!l;l‘ll}cﬂaﬂc?l]ﬂ?ha“"'sdwﬁyNsme” "STOR_RIB_ADAPTOR_INY _JOB" "activityExecutionid™ "2811980" "callerld" "null*,
“correlationtd™. "nul” "callBackServiceDataDetail rootProcessExecld". "MERCH_DUMMY_START_NIGHT_BATCH_PROCESS~535fdf

cd-
ac3e-4063-962-8c0aac20d7ba" "calBackServiceDataDetail rootProcess™ “"MERCH_DUMMY_START_NIGHT_BATCH_PROCESS",
"status”:"COMPLETED" "activity Status"."ACTIVITY_COMPLETED"}

Callback Response Response status: OK
Response payload : Jersey say : postersey say:
{"processhiame™ "MERCH_DUMMY _START_NIGHT_BATCH_PROCESS" "processExecutionid™ "MERCH_DUMMY _START_MNIGHT_B
ATCH_PROCESS~535fdfcd-
ac3e-4063-96(2-8c0aac20d7ba" "activityName". "STOP_RIB_ADAPTOR_INV_JOB" "activityExecutionkd™ "2911980" "callerle!” "null*
I i, DataDetail rootPr Execld"."MERCH_DUMMY_START_MIGHT_BATCH_PROCESS~535fd

‘ac3e-4063-9612-8c0aac20d7ba" "callBackServiceDataDetail rootProcess" "MERCH_DUMMY _START_MIGHT_BATCH_PROCESS",
“status™ "COMPLETED" "activity Status™ "ACTIVITY _COMPLETED"}

p

oK

All Callbacks - View Menu and Icons

You can customize the view of the table by using the options in the View Menu, see
Table 2-2, " Batch Jobs - View Menu/Icons and Description” for more information.

Batch Monitoring Toolbar

The toolbar contains the following icons and buttons.

Table 2-3 Batch Monitoring Toolbar - Icons/Buttons and Description

Icons/Buttons Description

Done Click Done to close the window.

External System Configuration

To access the External System Configuration window from the Tasks menu, select
<Schedule> -> Administration -> External System Configuration.
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External System Configuration

The External System Configuration screen allows the users to modify the following
properties of the External System:

1.
2.
3.

External Status URL
External Status Update Mode

External System Credentials

MERCH : External System Configuration x

External Status URL us.oracle

External Status Update Mode 5| | J

Credentials  devuser V4

Save SaveandClose  Cancel

Configuring System Wide External URL and Status Update Mode

1.
2

Open External System Configuration screen from sidebar

Specify External Status Update URL to configure the ReST service URL where
status updates should be sent. Updates will be sent using HTTP POST method.

Specify system wide External Status Update mode to NONE/FAILED/ALL. This will
be compared against Job level modes to decide whether to send a status update for
a job or not.

Click on Save to save the changes or click on Save and Close to save the changes
and close the screen.

A basic authentication is enabled for the External Status Update Rest Service End
point where status updates are sent to the external system from POM. The
credentials are configured in Enterprise Manager Console of WebLogic domain
where POM is deployed. Below are the details of credentials

1. Map name: External.oracle.retail.apps.poam.app.external
2. Alias name: {SCHEDULENAME} .externalstatusupdatealias

For example, RDE.externalstatusupdatealias, or
MERCH.externalstatusupdatealias

3. Credential type: password

Creating or Modifying External System Credentials in WebLogic

1.
2.

Open the External System Configuration screen from the sidebar.

If the External System Credential has not previously been created, click on plus (+)
icon to create it. Otherwise click the edit icon to modify it.

Enter User Name and Password of the External System in the Create External
System Credentials popup window.
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Mail Notifications

Create External System Credentials (]

* User Name WEBLOGIC

* password esesesss|

OK Cancel

4. Click OK to create or modify the credentials in the WebLogic instance.
© Information [x]

External System configured successfully

OK

Mail Notifications

POM leverages the Retail Platform Notification facility and e-mail capabilities to issue
alerts to users regarding specific instances during batch operations. Mail notifications
are sent when a Job fails and when the nightly cycle completes based on the
configured mail addresses.

Nightly Cycle Summary Report Mail Notification

raf-system_us
[Customer: POMCustomerName, Env: devlin3] MERCH Schedule, Nightly Cycle Summary, for 03-MAY-19

@ 1f there are problems with how this message is displayed, click here to view it in a web browser

ORACLE
Execution summary for business date 03-MAY-19

0 Status: Complete

POM EOD Summary Job Results 1 Jobs Errored

Total Execution Time 9.82 min Successes 345 START_RIB_ADAPTOR_INV_JOB
Average Execution Time 5.6 min Errors 1

Total Job Execution Time 058 min Skipped 18 .. See Report

Total POM Wait Time 9.23 min Skipped on Error 1

Cycle Start Time 22-MAR-19/ 0

Cycle End Time 22.MAR-19/ 00:08:57
Copyright © 2019, Oracle. AllRighis Reserved

The Nightly Cycle Summary report shows the snapshot of the entire Nightly Cycle
run. It includes metrics for averages and total execution times, POM idle time, cycle
start and end time, and so on. The report also includes the number of Jobs completed,
failed, skipped, and skipped on error.
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Mail Notifications

Job Error/Skipped On Error Mail Notification

raf-system_us
[Customer: POMCustomerName, Env: devlin3] ORASE Schedule, DT AO_RUN_GRP_PROD_STG_JOB SKIPPED_ON_ERROR, for 21-FEB-19

ORACLE

SKIPPED_ON_ERROR occurred on Mon Mar 11 08:23:38 EDT 2019

ORASE Schedule SKIPPED_ON_ERROR for 21-FEB-19
DT AO RUN GRP PROD STG JOB SKIPPED_ON_ERROR
Job Execution ID 17538. Job Description: DT_AO_RUN_GRP_PROD_STG_JOB

View in POM

Copyrght © 201, Oracle. Al Rights Reserved

The Error report shows the Job name that failed along with the corresponding Process
name, Job Execution id, Job Description, and the time the Job failed/skipped on error.
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